Installation and Licensing Guide
for IAR Embedded Workbench®
COPYRIGHT NOTICE

© Copyright 2001–2009 IAR Systems AB.

No part of this document may be reproduced without the prior written consent of IAR Systems AB. The software described in this document is furnished under a license and may only be used or copied in accordance with the terms of such a license.

DISCLAIMER

The information in this document is subject to change without notice and does not represent a commitment on any part of IAR Systems. While the information contained herein is assumed to be accurate, IAR Systems assumes no responsibility for any errors or omissions.

In no event shall IAR Systems, its employees, its contractors, or the authors of this document be liable for special, direct, indirect, or consequential damage, losses, costs, charges, claims, demands, claim for lost profits, fees, or expenses of any nature or kind.

TRADEMARKS

IAR Systems, IAR Embedded Workbench, C-SPY, visualSTATE, From Idea To Target, IAR KickStart Kit, IAR PowerPac, IAR YellowSuite, IAR Advanced Development Kit, IAR, and the IAR Systems logotype are trademarks or registered trademarks owned by IAR Systems AB. J-Link is a trademark licensed to IAR Systems AB.

Microsoft and Windows are registered trademarks of Microsoft Corporation.

EDITION NOTICE

Seventh edition: October 2009

Part number: ILG-7

Internal reference: P5, IMAE
Contents

Figures ...................................................................................................................... v
Preface .................................................................................................................... vii
  Who should read this guide ................................................................................ vii
  What this guide contains ................................................................................... vii
  Typographic conventions .................................................................................... viii
Introduction .......................................................................................................... 1
  How IAR Systems licensing works ................................................................. 1
  Stand-alone and network licenses .................................................................... 2
    Stand-alone licenses ....................................................................................... 2
    Network licenses ........................................................................................... 2
  Moving a license between computers .............................................................. 2
    Moving the license using a dongle .................................................................. 2
    Moving a stand-alone license using the license transfer functionality ........ 3
Installing and using two versions in parallel ...................................................... 3
Upgrading a product ............................................................................................. 3
Further information .............................................................................................. 4
Installing a product with a stand-alone license .................................................. 5
  Stand-alone licenses ........................................................................................ 5
  System requirements ......................................................................................... 5
Installing a stand-alone license ............................................................................ 6
  Installing the software ....................................................................................... 6
  Activating the license ....................................................................................... 10
Upgrading a product using a stand-alone license ................................................ 14
  Locating the license number and permanent key ....................................... 14
  Installing the product upgrade ....................................................................... 15
Installing a product with a network license ..................................................... 21
  Network licenses ............................................................................................. 21
    The license server package ........................................................................ 21
    The IAR Embedded Workbench software ................................................. 22
# Figures

1: Typing name, company, and stand-alone license number ........................................ 7
2: Typing the QuickStart key .................................................................................. 7
3: Selecting the stand-alone license lock type .......................................................... 8
4: Selecting the installation type for a stand-alone license ....................................... 9
5: Selecting the installation directory for a stand-alone license ............................... 10
6: Running the license activation program for a stand-alone product ......................... 11
7: Verifying the locking criteria for a stand-alone product ....................................... 12
8: Choosing registration method for a stand-alone license ........................................ 13
9: Installing the permanent stand-alone license key ............................................... 14
10: Locating license information ............................................................................ 15
11: Typing name and company ............................................................................... 16
12: The permanent key when upgrading a stand-alone license .................................. 17
13: Selecting the upgrade installation directory for a stand-alone license ................. 18
14: Selecting the type of upgrade for a stand-alone license ...................................... 19
15: Running the license activation program for a network license ............................. 25
16: Selecting the network license product to register ............................................. 26
17: Verifying the locking criteria for a network license ........................................... 27
18: Choosing registration method for a network license .......................................... 28
19: Installing the permanent network license key ................................................... 29
20: Typing name, company, and license number for a network license ..................... 30
21: Providing the permanent network license key ................................................... 31
22: Selecting the installation directory for a network license ................................... 31
23: Selecting the installation type for a network license .......................................... 32
24: The license transfer process ................................................................................ 38
25: Selecting the license to transfer ......................................................................... 39
26: Receiving the transfer ID .................................................................................. 39
27: Importing the license ......................................................................................... 40
28: Reading the transfer ID from file ....................................................................... 40
29: Receiving the target ID ..................................................................................... 41
30: Reading the target ID from file ......................................................................... 42
31: Receiving the license transfer code .................................................................... 43
32: Reading the license transfer code from file .............................................................. 44
Preface

Welcome to the Installation and Licensing Guide for IAR Embedded Workbench®. It contains detailed information about how to install an IAR Embedded Workbench product, how to activate the license, register the product, and how to install a product upgrade.

Who should read this guide

You should read this guide if you:

- Have purchased a stand-alone license and need more information about installation and licensing than is available in the Quick Reference booklet
- Are about to upgrade your existing license
- Are a network or system administrator responsible for installing a network license.

What this guide contains

This guide contains these chapters:

- Introduction gives a general introduction to the installation and licensing procedure and describes the differences between different license types.
- Installing a product with a stand-alone license describes step by step how to install and activate a single-user license. It also describes how to upgrade or re-install IAR Embedded Workbench.
- Installing a product with a network license gives a step-by-step description of how to install both the license server software and the client software in a multi-user environment. This chapter also describes how to upgrade both the license server and the client software.
- Transferring a license gives detailed descriptions of how to move a license to another computer, either temporarily or permanently.
Typographic conventions

This guide uses these typographic conventions:

<table>
<thead>
<tr>
<th>Style</th>
<th>Used for</th>
</tr>
</thead>
</table>
| **computer** | • Source code examples and file paths.  
|          | • Text on the command line.  
|          | • Binary, hexadecimal, and octal numbers.  |
| **parameter** | A placeholder for an actual value used as a parameter, for example filename.h  
|          | where filename represents the name of the file.  |
| **[option]** | An optional part of a command.  |
| **a|b|c** | Alternatives in a command.  |
| **(a|b|c)** | A mandatory part of a command with alternatives.  |
| **bold** | Names of menus, menu commands, buttons, and dialog boxes that appear on the screen.  |
| **italic** | • A cross-reference within this guide or to another guide.  
|          | • Emphasis.  |
| **...** | Indicating that the previous item can be repeated an arbitrary number of times.  |
| ![Icon](icon1.png) | Instructions specific to the IAR Embedded Workbench® IDE interface.  
| ![Icon](icon2.png) | Instructions specific to the command line interface.  
| ![Icon](icon3.png) | Helpful tips and programming hints.  |
| ![Icon](icon4.png) | Warnings.  |

Table 1: Typographic conventions used in this guide
Introduction

This chapter introduces the IAR Systems licensing system. It gives an overview of the installation and license activation procedure, and of the different license types.

How IAR Systems licensing works

Each IAR Embedded Workbench® product comes with a software license. There are two types of IAR Systems license keys associated with a license:

- The QuickStart key, which allows you to use the product for 30 days after installation
- The permanent key, which opens up the product for permanent usage.

You install IAR Embedded Workbench using the QuickStart key. This allows you to start using the product immediately after installation and 30 days onward. The QuickStart key is included in the welcome letter of your product package.

During the 30-day period, you must activate your license by registering the product with IAR Systems. After registration, you will obtain the permanent key from IAR Systems. By installing the permanent key, the product is opened up for permanent usage. Registering the product also entitles you to one year of free upgrades and prioritized technical support, depending on your purchased product.

As it can take up to 5 business days until you receive the permanent key, you should register the product as soon as possible after installation.

Note: If you do not activate and register your product, you will be unable to run it after the 30-day period.

Note: Before you make any major configuration changes to the hard disk—like reformatting the disk, changing the file system, or exchanging the hard disk for a new one—or altering the IAR Systems part of the registry, a license transfer to another computer must be performed. Otherwise, the license management system will not recognize your license. After the configuration changes have been made, the license can be transferred back to the original computer.
Stand-alone and network licenses

When purchasing IAR Embedded Workbench you can choose between two kinds of permanent licenses: the stand-alone license for single users and the network license for multiple users.

**STAND-ALONE LICENSES**

A *stand-alone license* is a single-user license, locked either to the computer where the software is installed, or to a hardware lock (dongle). A *dongle* is a device you attach to the computer’s USB port or parallel port.

*Note:* A dongle is part of your single-user product package only if you have explicitly ordered it.

**NETWORK LICENSES**

A *network license* is a multi-user license, located on a *license server computer* and used by multiple users on a network.

The network license is locked either to a dongle that you attach to the computer’s USB port (or parallel port), or to the computer where the license server software is installed. The dongle, which is included in the product package when you purchase a network license, allows you to move the network license to another server computer. Using a dongle is the recommended default for network licenses, because it makes it easier for you to recover from a server failure.

The network license can be used on all *client computers* on the same subnetwork where IAR Embedded Workbench is installed. However, the network license is made for a maximum number of concurrent users, and the license server software keeps track of the current number of users.

**Moving a license between computers**

Even though the IAR Systems license is locked to a dongle or to a permanent key with a transferable license, it is still possible to move it to another computer.

**MOVING THE LICENSE USING A DONGLE**

If you regularly work on two or more computers, you should lock your license to a dongle. By installing IAR Embedded Workbench on each of your computers, and locking the license to a dongle, you only need to move the dongle when switching to another computer.

See *Moving a license locked to a dongle*, page 37, for a detailed description of the procedure.
Note: If you need a license that can be moved easily between different PCs, contact your nearest IAR Systems office or your local distributor and you will be offered a dongle. Do not install the product until you have received the dongle.

MOVING A STAND-ALONE LICENSE USING THE LICENSE TRANSFER FUNCTIONALITY

If you need to transfer your license from one computer to another and you have a stand-alone license that is locked to a computer—for example, when upgrading to a new PC—you should use the license transfer functionality. It allows you to export the license from one computer and import it to another computer.

See Moving a stand-alone license locked to a computer, page 38, for a detailed description of the procedure.

Installing and using two versions in parallel

If you want to install two versions of the software on the same computer, you must make sure the new version is placed in an installation directory in a directory separate from the old version to avoid confusion. Before running the new software version for the first time, you must start the old version and make sure the Reload last workspace at startup option is turned off (on the Project page in the Tools>Options dialog box), otherwise a project file opened in the wrong version might become unusable in its original software version.

If you start the software by double-clicking a project file, it is the software version that was last run that is started, regardless of which version the project file was created in. This could make the project files unusable if the wrong version is started by mistake. To avoid this, always start the correct version of the software first, and then open the desired project file from the File menu.

Also make sure to check the compatibility of the object files created by the different versions. This information can be found in the release notes of your product.

Upgrading a product

You perform a product upgrade on the same computer where a previous version of the same product already is installed. An upgrade does not change the license type of the existing product—stand-alone license or network license. You must continue using the same license type and license lock after installing the upgrade.

You can replace your existing product installation with the upgrade, that is, use exactly the same installation directory. In that case, you first need to create backup copies of all
files you might have modified. You should then uninstall the previous product version, before you install the upgrade.

To uninstall IAR Embedded Workbench, select the appropriate **Uninstall IAR Embedded Workbench** item from the Windows Control Panel. If you have created your own files in the installation directory, they will remain intact.

For details about upgrading a stand-alone license, see *Upgrading a product using a stand-alone license*, page 14.

For information about upgrading a network license, see *Upgrading a product using a network license*, page 34.

### Further information

If this guide does not answer your questions or solve your problems concerning the installation or licensing, you can:

- Read the release notes for recent information that may not be included in this guide. The release notes are available in the Information Center and on the product CD.
- View the technical notes on the Technical Support pages on the IAR Systems web site: [www.iar.com](http://www.iar.com)
- Contact your IAR Systems software distributor for technical support. The address information is available on the IAR Systems web site: [www.iar.com](http://www.iar.com).

Be prepared to provide the following information: your license number, the type of license lock you use, when and where you purchased the product, and a detailed description of the problem.
Installing a product with a stand-alone license

This chapter describes the stand-alone license, how to install and activate it, and how to re-install or upgrade your installation.

Stand-alone licenses

The stand-alone license, which is intended for single users, locks the license to specific hardware. You can choose to lock your stand-alone license to:

- A dongle, which is a device you attach to the computer’s USB port or parallel port. This means that the license can be used on another computer by moving the dongle. The dongle is generic, which means that you only need one dongle even if you run IAR Embedded Workbench for several different target processors on the same computer.
  
  **Note:** If you want to lock your license to a dongle, you have to order it specifically when buying your IAR Systems product.

- The computer’s internal hardware. This means that the license can only be used on this specific computer, unless you transfer the license.

System requirements

To install and run IAR Embedded Workbench, you need:

- A PC with Microsoft Windows Vista/XP(SP2)/2000(SP4).
- Internet Explorer 6 or higher
- A Pentium processor with at least 1 Gbyte of RAM and up to 1.5 Gbyte of free disk space depending on the product you are using.
- Adobe Acrobat Reader to access all the product documentation.

**Note:** To install software, you must have administrator’s rights to the system.
Installing a stand-alone license

The IAR Embedded Workbench installation is a three-stage procedure:

1. Install IAR Embedded Workbench using the QuickStart key, which allows you to use the product for 30 days.

2. During this 30-day period, activate your license by registering the product with IAR Systems. Within 5 business days, you will receive the permanent key for your license.

3. Install the permanent key. This opens up the product for permanent use.

   If you are to install a product upgrade, you should not follow the installation procedure described below. Instead, follow the instructions in Upgrading a product using a stand-alone license, page 14.

INSTALLING THE SOFTWARE

1. Make sure the date is set correctly on your computer. After the initial installation, the date must not be changed until you have received and installed the permanent license key.

2. Remove any dongles.

3. Insert the IAR Embedded Workbench installation CD. The installation program should start automatically. If it does not, run the autorun.exe program from the CD.

4. Click Install IAR Embedded Workbench.

5. Accept the license agreement when prompted.
6 Type your name, company, and the 17-character license number available in your welcome letter:

![Figure 1: Typing name, company, and stand-alone license number](image1.png)

7 Type the 16-character QuickStart key available in your welcome letter:

![Figure 2: Typing the QuickStart key](image2.png)
Installing a stand-alone license

**Note:** If you are re-installing the software and you have already registered it, you should type or paste the permanent key instead of the QuickStart key.

8 Select the type of license lock you wish to use, either My computer or Hardware dongle:

![Image of license lock selection screen]

Figure 3: Selecting the stand-alone license lock type

If you select Hardware dongle, do not attach the dongle until you are instructed to do so by the installation program. Do not select this option if you have not received a dongle.
9 If prompted, select either a Complete or a Custom installation:

![Image showing setup type options: Complete and Custom]

*Figure 4: Selecting the installation type for a stand-alone license*

If you choose **Custom**, select the components you want to install in the next dialog box.

Note that this step does not always apply.
10 Accept the default installation directory or specify a directory of your choice:

![Figure 5: Selecting the installation directory for a stand-alone license](image)

If your new installation is incompatible with an existing installation, a dialog box informs you and you must then choose another installation directory.

11 Review the settings for the installation and click **Install** to install the program files.

12 Attach the dongle when you are instructed to do so by the installation program.

**ACTIVATING THE LICENSE**

At this point, you can use IAR Embedded Workbench for a period of 30 days. To open up the product for permanent use, you have to activate the license: first register the product with IAR Systems to receive a permanent key, and then install the permanent key.

If you do not register the product, you will be unable to use the software after the 30-day period.
Registering the product

1. When the program files have been installed, a license activation program is started:

![Image of license activation program]

*Figure 6: Running the license activation program for a stand-alone product*

2. The next dialog box shows the product information to be sent to IAR Systems. Verify that the product information is correct.
3 In the next dialog box, verify the locking criteria:

Figure 7: Verifying the locking criteria for a stand-alone product
4 In the next dialog box, select how to register:

- Register now using your installed web browser.
  You must fill in all fields marked with an asterisk (*). Make sure to click the Submit button on the resulting web page to send the information to IAR Systems.

- Register later.
  The information you typed during the installation is saved. However, you must remember to run the license activation program at a later time to send the information to IAR Systems. You do this by selecting IAR Systems License Activation in the Windows Start menu.

5 Finish the activation program and the installation program.

**Installing the permanent key**

Within 5 business days after sending in your registration, the permanent key will be sent to you via the email address that you typed into the registration form. Install the permanent key as follows:

1 Select and copy the permanent key from the email message, according to the instructions included in the message.
2 Choose **IAR Systems License Manager** from the Windows **Start** menu. (Make sure you run it with administration privileges.)

3 In the License Manager window, choose **License>Install.**

4 Paste the permanent key into the text field:

![Figure 9: Installing the permanent stand-alone license key](image)

5 Click **Install.**

You are now finished with the IAR Embedded Workbench installation.

---

**Upgrading a product using a stand-alone license**

You perform a product upgrade on the same computer where a previous version of the same product already is installed. You cannot change the license type and license lock when installing the upgrade.

**LOCATING THE LICENSE NUMBER AND PERMANENT KEY**

The license number and permanent key can be found by using the IAR License Manager.

1 Start the **IAR Systems License Manager** from the Windows **Start** menu. (Make sure you run it with administration privileges.)
2 Locate your product in the window, and double-click the license listed below the product to display the license number and permanent key.

![Figure 10: Locating license information](image)

The license number can also be found in the letter accompanying the upgrade.

The permanent key can also be found in the email message you received from IAR Systems after you registered the original product.

**INSTALLING THE PRODUCT UPGRADE**

Before you install the upgrade, decide if you wish the upgrade to completely replace your existing product installation, or if you wish to keep your existing installation and install the upgrade in another directory.

If you wish to replace your existing installation, first do as follows:

- Make copies of linker configuration files, libraries, and any other product files you have modified in your existing installation. These files will otherwise be overwritten. Your own files will remain intact.

- Uninstall the current version of the product by selecting the appropriate Uninstall IAR Embedded Workbench item from the Windows Control Panel.
Then perform the following steps on the computer where you currently have the product installed:

1. Insert the IAR Embedded Workbench installation CD. The installation program should start automatically. If it does not, run the autorun.exe program from the CD.

2. Click Install IAR Embedded Workbench.

3. Accept the license agreement when prompted. By clicking the Accept button, you confirm that you have read and understood the license agreement.

4. Type your name and company. The 17-character license number should already be filled in. If it is not, you must type the license number of the product you are upgrading; see Locating the license number and permanent key, page 14.

Figure 11: Typing name and company
The permanent key should already be filled in. If it is not, you must provide the permanent key of the product you are upgrading; see Locating the license number and permanent key, page 14.

Figure 12: The permanent key when upgrading a stand-alone license
Upgrading a product using a stand-alone license

6 Accept the default installation directory or specify a directory of your choice. If you want the installation directory to be the same as in the previous installation, make sure you have first uninstalled the previous version.

![Figure 13: Selecting the upgrade installation directory for a stand-alone license](image)

If your new installation is incompatible with an existing installation, a dialog box will inform you and you must then choose another installation directory.
7 If prompted, select either a Complete or a Custom installation:

![Image of setup type selection]

If you choose Custom, select the components you want to install in the next dialog box. Note that this step does not always apply.

8 Review the settings for the installation and click Install to install the program files. You are now finished with the IAR Embedded Workbench upgrade.
Installing a product with a network license

This chapter gives information to the system or network administrator about how to install the IAR Systems license server software on the designated server and IAR Embedded Workbench® on the client computers.

**Network licenses**

A network license is a multi-user license, consisting of license server software on one PC, and individual installations of IAR Embedded Workbench on other computers—clients—in the same network. The network license is locked to the computer where the license server software runs, either to the server itself or to the dongle attached to it.

The network license can be used by all client computers where IAR Embedded Workbench is installed. However, the network license is made for a maximum number of concurrent users, and the license server software keeps track of the current number of users. Note that you will have one license number for all client installations, independent of the number of users the license covers.

**THE LICENSE SERVER PACKAGE**

When you order a network license, you receive:

- 1 CD with the license server software
- 1 dongle
- 1 client package with IAR Embedded Workbench.

Install the license server software on a computer that you want to use for the license server.

The use of a dongle is optional but recommended. With the dongle attached to the license server computer you can easily move the license server software to a different server computer, for example, in case of server failure. If the dongle is not attached during installation, the network license will be locked to that specific server computer.

The license server software is generic and you can use this program for all IAR Embedded Workbench products you install.
THE IAR EMBEDDED WORKBENCH SOFTWARE

The client software can be installed on as many client computers as you want.

Each time an IAR Embedded Workbench using a network license starts up, it requests permission to run from the license server. If the maximum number of concurrent users has not been reached, the license server will grant permission to use the network license.

When a client stops using the product, the permission to use the network license remains locked to that client for another thirty minutes before it is released to another client. In the IAR License Manager program you can view the status of the license. This program is installed with the product.

System requirements

For the license server computer, we recommend:

- A 1 GHz or faster Pentium II processor with at least 256 Mbytes of RAM (for Vista 1 Gbyte), and 410 Mbytes of free disk space on the Windows system drive. The license server itself uses very little processor power, but a fast system is necessary to ensure that the licensed IAR Embedded Workbench products in the network operate at an acceptable speed.
- A web browser and Adobe Acrobat Reader to access all the product documentation.

On a PC running Windows XP/Service Pack 2 or Vista, turn off the Windows firewall or add UDP port 5093 as an exception.

Note: To install software, you must have administrator’s rights to the system.

For the client computers, the requirements are the same as for a stand-alone license; see System requirements, page 5.

Network requirements for the IAR license server

If you run the IAR Systems tools on a PC (client) and use network licensing, the license server will be contacted automatically to obtain a license.

The client-server communication is handled via the UDP protocol at port 5093 on an IP network.

If a firewall or network bridge is installed between the client and the server, for example Windows Firewall which comes with Windows XP/Service Pack 2 and some other Windows versions, turn it off or make sure that UDP packets at port 5093 are routed.
Installing a product with a network license

UDP broadcast packets at port 5093 are also used in these situations:

- During installation of the tools on a client to automatically find and set up the server location in the license.ini file.
- During a broadcast from the IAR license manager when Show all is selected. As a last resort if the client does not find/know any server.

In network configurations where the broadcast function is not available or the license server is not yet up and running, the server location must be manually typed in the license.ini file.

The license.ini file is located at `X:\Program Files\Common Files\IAR systems\Licenses\Embedded Workbench\yy\zz\`, where X is the drive where the operating system is installed, yy is the product name, and zz is the feature version.

In the license.ini file, the Loc0 entry must be added under the [LicenseLocation] category:

Syntax:

```
LocX=<feature name>,<feature version>,server:<IP address>
```

The LocX defines where to find the specific feature. X must start from 0, and if there are more than one licensed component (feature), the X numbers must be in continuous order.

Example:

```
[LicenseLocation]
Loc0=EWV850,01_WIN,server:192.10.1.1
Loc1=EWV850-R,01_WIN,server:192.10.1.1
```

Installing a product using a network license

The recommended way to install a product with a network license is the following four-stage procedure:

1. Install the IAR License Server software on a server computer.
2. Activate your network license by registering the product with IAR Systems. Within 5 business days, you will receive the permanent key for your license.
3. Install the permanent key on the license server.
4. Install IAR Embedded Workbench on the client computers, by using the permanent key.

**Important:** If you wish to add this network license to an already installed IAR License Server, see Using an already installed license server, page 33, for instructions. Do not follow the installation procedure described below.
Installing a product using a network license

Note: The procedure described below does not allow you to install and run IAR Embedded Workbench on the client computers until you have received the permanent key from IAR Systems. If you need or want to run IAR Embedded Workbench on the client computers immediately after receiving your product package, see Alternative installation procedure, page 32.

INSTALLING THE LICENSE SERVER SOFTWARE

The permanent key you receive after registering is only valid for the computer you registered the product from.

Note: Unless you use a dongle, it is very important that you decide from the beginning which computer to use for the license server, because the license server will be locked to that computer.

1 Choose a suitable server computer for the license server software, see the recommendations in System requirements, page 22.

2 Remove any dongles.

3 Insert the IAR License Server installation CD. The installation program should start automatically. If it does not, run the autorun.exe program from the CD.

4 Click Install the IAR License Server.

5 Accept the license agreement when prompted. Select I accept the terms of the license agreement and click Next, to confirm that you have read and understood the license agreement.

6 Confirm or modify the settings for the installation and then review them. Click Next to install the program files.

   The server files will be installed in the Common Files directory. The license server software will start automatically after installation. It will also start automatically every time you restart the computer.

7 You will be asked if you want to activate a network license. Select Activate a network license and click the Finish button.

ACTIVATING THE LICENSE

Before you use your network license, you must activate it: first register the product with IAR Systems to receive a permanent key, and then install the permanent key.
Registering the product

When the program files have been installed, a license activation program is started:

![Image of the license activation program](image.png)

*Figure 15: Running the license activation program for a network license*

Click **Next**.
2 In the License Activation application, select **For license server, register a network license**. and type the 17-character license number of the IAR Embedded Workbench product that you want to register.

![Figure 16: Selecting the network license product to register](image)

3 The next dialog box shows the product information to be sent to IAR Systems. Verify that the product information is correct.
4 In the next dialog box you will be asked to verify the locking criteria. If your license server uses a dongle, select **Hardware dongle** and make sure the dongle is attached to the license server computer.

5 In the next dialog box you must choose how to send in your registration to IAR Systems, choose between:

- Register using your web browser—this is the recommended way of registering.
- Via email—this option will send an email message to IAR Systems. If this should fail, you will be notified with instructions on how to send the information yourself.
- Register later—the information you typed is saved in the Windows registry. In case of a failure during the registration procedure, you can find the information also in a file called `registration.txt` in the program folder, for example `..\IAR Systems\Embedded Workbench 5.x\Product_Name\registration.txt`. However, you must remember to run the license activation program at a later time to
Installing a product using a network license

send this file to IAR Systems, by selecting **IAR Systems License Activation** on the Windows **Start** menu.

**Figure 18: Choosing registration method for a network license**

Select your choice and click **Finish**.

6 In the form, type your contact information. In the web form, you must fill in all fields marked with an asterisk (*), and in the email form all fields in boldface. Make sure to click the **Submit** button on the resulting web page, or the **Send** button in the email form, to send the information to IAR Systems. When you have submitted the registration, exit the installation program.

Within five business days after submitting your registration, you will receive the permanent key via email. Then you should:

- Install the permanent key on the license server computer as described in **Installing the permanent key on the license server computer**, page 29.
- Install the client software as described in **Installing IAR Embedded Workbench on client computers**, page 30.

When activating products with a network license, it is important that you register only the **license server** installation. Do not send in registration information from computers in the network where you have installed IAR Embedded Workbench only.
INSTALLING THE PERMANENT KEY ON THE LICENSE SERVER COMPUTER

Within five business days after sending in your registration, the permanent key will be sent to you via the email address that you typed into the registration form. Install the permanent key as follows:

1. Select and copy the permanent key from the email message, according to the instructions included in the message.

2. Choose IAR Systems License Manager from the Windows Start menu. (Make sure you run it with administration privileges.)

3. In the License Manager window, choose License>Install.

4. Paste the permanent key into the text field:

![Figure 19: Installing the permanent network license key](image)

5. Click Install. You will be prompted to verify that you are indeed installing a network license.

   **Note:** To see your license, you must choose View>All Servers.

You are now finished with the installation of the IAR License Server, and should continue with the installation of IAR Embedded Workbench on the client computers. To facilitate this, you should distribute the permanent key to all client computers:

- Make the permanent key available to each client computer; either send it via email or save it to a network file to which the client computers have access.

- Before installing IAR Embedded Workbench on the client computers, start the IAR License Manager and verify that you can see the product license you just installed.
INSTALLING IAR EMBEDDED WORKBENCH ON CLIENT COMPUTERS

The following steps should be repeated on each client computer.

Note: For performance reasons, you should avoid to install IAR Embedded Workbench on the computer where the license server software is installed.

1 Insert the IAR Embedded Workbench installation CD. The installation program should start automatically. If it does not, run the autorun.exe program from the CD.

2 Select Install IAR Embedded Workbench.

3 You must accept the license agreement when prompted. By clicking the Accept button, you confirm that you have read and understood the license agreement.

4 Type your name, company, and the 17-character license number available in the welcome letter of your IAR product:

Figure 20: Typing name, company, and license number for a network license
5 Provide the permanent key, which the system administrator should have made available:

![Image of license key entry](image1)

**Figure 21:** Providing the permanent network license key

6 Accept the default installation directory or specify a directory of your choice:

![Image of installation directory selection](image2)

**Figure 22:** Selecting the installation directory for a network license
If your new installation is incompatible with an existing installation, you need to choose another installation directory.

7 If prompted, select either a Complete or a Custom installation:

![Figure 23: Selecting the installation type for a network license](image)

If you choose Custom, select the components to install in the next dialog box.

8 Review the settings for the installation and click Next to install the program files.

Make sure to repeat the above steps on each client computer where you want to be able to run IAR Embedded Workbench.

You are now finished with the IAR Embedded Workbench installation.

---

**Alternative installation procedure**

The regular installation procedure does not give you the possibility to install and run IAR Embedded Workbench on the client computers until you have received the permanent key from IAR Systems. Receiving the key can take up to five business days after registration. If you need or want to run IAR Embedded Workbench on the client computers immediately after receiving your product package, proceed as follows.

1 Install the client software as described in *Installing IAR Embedded Workbench on client computers*, page 30, with the following exception: in step number 5, on page 31, instead of providing the permanent key, type the QuickStart key available in your welcome letter.
Installing a product with a network license

2 Install the license server software as described in Installing the license server software, page 24.

3 Activate the license by registering the License Server product as described in Registering the product, page 25.

4 Make the permanent key available to each client computer by sending it via email.

5 Make sure that the license server software is up and running on the license server computer.

6 On each client computer, install the permanent key as described in Installing the permanent key, page 13.

Note: You should be aware that the installation procedure described above has some disadvantages compared to the regular procedure:
- It requires you to perform an additional set of steps on each client computer.
- A subsequent product upgrade will require you to manually provide the permanent key on each client computer when you install the IAR Embedded Workbench upgrade.

Using an already installed license server

If you already have an IAR License Server installed and you wish to use it for your new IAR Embedded Workbench product, proceed as follows:
- On the license server computer, choose IAR Systems License Activation from the Windows Start menu. In the license activation application, click Next.
- Continue to activate your license as described from step 2 in Activating the license, page 24.
Upgrading a product using a network license

It is possible to receive new versions of both the IAR Embedded Workbench software and the license server software.

You perform a product upgrade on the same computer where a previous version of the same product already is installed. You continue to use the same license type and license lock after installing the upgrade.

UPGRADING THE CLIENT SOFTWARE

Before you install the upgrade on the client computers, decide if you wish the upgrade to completely replace your existing product installation, or if you wish to keep your existing installation and install the upgrade in another directory. If you wish to replace your existing installation, first do as follows:

● Make copies of linker configuration files, libraries, and any other product files you have modified in your existing installation. These files will otherwise be overwritten. Your own files will remain intact.

● Uninstall the current version of the product by selecting the appropriate Uninstall IAR Embedded Workbench item from the Windows Start menu.

Then follow the instructions in Installing IAR Embedded Workbench on client computers, page 30, for each client computer where you have the previous version of your IAR Embedded Workbench installed.

Make sure to do this on each client computer. You are then finished with the IAR Embedded Workbench upgrade.

For information about locating the license number and permanent key, see Locating the license number and permanent key, page 14.

UPGRADING THE LICENSE SERVER SOFTWARE

If you have received an upgrade of the network license server software, perform the following steps on the computer where you have the current license server installed.

Note: The installation procedure will shut down the license server and make all network licenses temporarily unavailable.

1 First uninstall the current version of the license server software by choosing the appropriate Uninstall IAR License Server item from the Windows Start menu.

2 Follow the instructions in Installing the license server software, page 24.

3 If you are asked to activate the license or register the product, select Finish the installation without activating a license. You should not register the license server upgrade, because you already have registered the product when you first installed it.
You are now finished with the IAR License Server upgrade.

**Adding more users to a network license**

If the number of concurrent users permitted by your network license is not sufficient, you can add more users to the license. To do this, you must contact your software distributor or IAR Systems to purchase an extended network license.

Install the new permanent key on the license server computer as described in *Installing the permanent key on the license server computer*, page 29.
Adding more users to a network license
Transferring a license

This chapter describes how you can move a license between computers, using either a dongle or the license transfer functionality.

Moving a license locked to a dongle

If you have a license locked to a dongle, you can use the license on another computer by moving the dongle.

MOVING A STAND-ALONE LICENSE

If you need to transfer your license between computers on a regular basis, you should purchase a stand-alone license that includes a dongle to which you lock the license.

1 Install IAR Embedded Workbench on computer A using the QuickStart key as described in Installing the software, page 6. Specify hardware dongle as the type of license lock to be used.

2 Activate the license and install the permanent key as described in Activating the license, page 10.

3 Make the permanent key available to computer B, for instance by saving it to a file.

4 Install IAR Embedded Workbench on computer B as described in Installing the software, page 6, but with one important exception: instead of using the QuickStart key, type the permanent key. Select Hardware dongle as the type of license lock to be used. When the installation program asks you to, move the dongle to computer B.

You can now use IAR Embedded Workbench on both computers by simply moving the dongle between them.

MOVING A NETWORK LICENSE

The network license should typically be locked to the dongle that is included in the product package. To move the network license to a new license server computer, for example in the case of server failure, do as follows:

1 Install the license server software on the new computer as described in Installing the license server software, page 24. Do not activate the license or register the product.

2 Make the permanent key available to each client computer by sending it via email.

3 On each client computer, re-install the permanent key as described in Installing the permanent key, page 13.
Moving a stand-alone license locked to a computer

In some cases you might want to transfer your stand-alone license to another computer, for example when purchasing a new computer. To transfer a stand-alone license between two computers, the license must first be de-activated on the old computer and then activated on the new computer. For this to work correctly, license and host information must be transferred between the two computers.

The picture below gives an overview of the license transfer process:

![License transfer process diagram]

**INSTALLING THE PRODUCT ON THE NEW COMPUTER**

1. On the old computer, make the permanent key available to the new computer by saving it to a file. For information on how to locate the permanent key, see *Locating the license number and permanent key*, page 14.

2. Install the product according to the instructions in *Installing a stand-alone license*, page 6.

**CREATING THE TRANSFER ID ON THE OLD COMPUTER**

Next you create a transfer ID on the old computer, identifying the transfer of the existing license.

1. On the old computer, choose *IAR Systems License Manager* from the Windows Start menu. (Make sure you run it with administration privileges.)

2. In the License Manager window, choose *License > Transfer*. 
3 Select **Export a license from this PC to another PC** and select the license to transfer:

![Figure 25: Selecting the license to transfer](image)

4 The next dialog box displays the transfer ID, which you will need on the new computer:

![Figure 26: Receiving the transfer ID](image)

5 Click **Save To File** and save the transfer ID to a file that you have access to on the new computer.

6 Click **Next** and keep the **Transfer License** dialog box open on the old computer. You will return to the next dialog box later.
Moving a stand-alone license locked to a computer

**CREATING THE TARGET ID ON THE NEW COMPUTER**

Next you import the transfer ID to the new computer and create a target ID, identifying the new host for the license.

1. On the new computer, choose **IAR Systems License Manager** from the Windows Start menu. (Make sure you run it with administration privileges.)

2. In the License Manager window, choose **License>Transfer**.

3. Select **Import a license to this PC from another PC**:

4. In the next dialog box, provide the transfer ID you received in step number 4, on page 39. Click **Read From File** and locate the file to which you saved the transfer ID:
5 The next dialog box displays the target ID, which you will need on the old computer:

![Figure 29: Receiving the target ID](image)

6 Click **Save To File** and save the target ID to a file that you have access to on the old computer.

7 Click **Next** and keep the license transfer dialog box open on the new computer. You will return to the next dialog box later.
Moving a stand-alone license locked to a computer

CREATING THE LICENSE TRANSFER CODE ON THE OLD COMPUTER

Next you import the target ID to the old computer and create a license transfer code that will activate the license on the new computer. In the process, the license will become inactive on the old computer.

1. On the old computer, provide the target ID you received above. In the dialog box, click Read From File and locate the file to which you saved the target ID:

![Figure 30: Reading the target ID from file]

2. Click Transfer. The license now becomes inactive and can no longer be used on the old computer.
3 The next dialog box displays the license transfer code, which you will need on the new computer:

![Image of License Transfer Code dialog box]

*Figure 31: Receiving the license transfer code*

4 Click **Save To File** and save the license transfer code to a file that you have access to on the new computer.

**Warning:** If you lose the license transfer code, you will not be able to activate the license on the new computer. This means that the license cannot be used on any computer.

5 Click **End** to complete the transfer of the license on the old computer.
ACTIVATING THE LICENSE ON THE NEW COMPUTER

Finally, you import the license transfer code to the new computer.

1. On the new computer, provide the license transfer code you received above. In the dialog box, click Read From File and locate the file to which you saved the transfer code:

   ![Figure 32: Reading the license transfer code from file](image)

2. Click Complete to complete the transfer of the license to the new computer.

   The license has now been activated on the new computer.
activating the license ........................................24
stand-alone license ........................................10
Adobe Acrobat Reader ....................................5, 22
alternative installation procedure ....................32
back-up copies ..............................................3
back-up files ................................................15
bold style, in this guide ..................................viii
client computers
  installing IAR Embedded Workbench ............30–32
  system requirements .................................22
  upgrading a product ................................34
command line options, typographic convention ....viii
command prompt icon, in this guide ..............viii
components to install
  selecting for a stand-alone license ...............9
  selecting on client computers ....................32
copyright ....................................................ii
distributor, of software .................................4
documentation, accessing ..............................5, 22
dongle
  using with network license .......................21
  using with stand-alone license ................5
free product upgrades ..................................1
hardware lock. See dongle
IAR Embedded Workbench
  documentation, accessing ..............................5, 22
  installing on client computers ....................30–32
  replacing with new version .......................3
  sharing license server software between IAR products .33
IAR Systems License Manager ..................14, 29
IAR Systems web site ................................4
IAR Technical Support ................................4
icons, in this guide .......................................viii
installation directory, using for product upgrade .3
installing .......................................................3
  IAR Embedded Workbench on client computers ...30–32
  network license .......................................23–24, 29–32
  alternative procedure ................................32
  license server software ..............................24, 29
  product upgrade ......................................34
  stand-alone license ....................................6–8, 10–11, 13–14
  product upgrade ......................................15, 17–19
italic style, in this guide .................................viii
license activation program ..........................11, 25
License Manager ...........................................14, 29
license server computer ................................2
  selecting ..................................................24
system requirements ..................................22
license server software
  installing ..................................................24, 29
  upgrading ................................................34
  using for several products ......................33
license transfer ............................................2
license types ...............................................2
U

upgrading a product ........................................ 3
  license server software ................................. 34
  on client computers ................................. 34
  stand-alone license ......................... 14–15, 17–19
users, adding to network license ..................... 35

V

vendor, of software ........................................ 4

W

warnings icon, in this guide ......................... viii
web browser
  for accessing product documentation ........ 5, 22
  using to register product ..................... 13, 27
web site, IAR Systems .................................. 4